NEW FEATURES in TIMESLIPS 2015

- Redesigned Client Information dialog for quicker access and a look consistent with other dialogs.
- New Payments Receipt feature lets you print and email receipts for payments.
- Improved Change Classification shows key information about a client you are preparing to make inactive or close.
- Completely redesigned electronic (Audit House) billing, including multiple Audit House settings for the same client.
- Enhanced Reprint Bills displays additional information, including number of pages, before printing. You may easily type-search and sort the various columns presented in the Reprint Bills dialog.
- Compatible with Windows speech recognition.
- Automatic Time Capture enhanced.
- Watermarks on draft bills.
- Filter Tasks (Activities) at the client level to limit the tasks that appear when entering slips for the client.
- Second address for client.
- Updated conflict check feature with an improved Text Search dialog with more search scope options.
- Compatible with Windows 8.1.

NEW FEATURES in TIMESLIPS 2014

- Automatic Time Capture. Timeslips can now monitor the activity of the various windows and applications you’re running and keep track of the time that each window is active. TimeCapture keeps track of the time spent on individual documents within applications like Microsoft Word, web sites opened in your browser, and all other desktop activity. This feature replaces the TSTimer application. Functions of the TSTimer are now included in the new TimeCapture application.
- Timeslips Calendar (added in version 2013) now syncs with Google calendar.
- Customize the Slip List to control number of slips and type of information displayed with slip count.
- Enter and view slips in the same dialog.
- TAL Pro, the Timeslips connection to QuickBooks, has been enhanced and includes among other improvements, a “ready to post” dialog that presents the transactions to be posted to QuickBooks.
• No CD’s. This version is available by download only.
• Compatible with Windows 8.

NEW FEATURES in TIMESLIPS 2013
• Integrated calendar including monthly view showing billed time. You may color code events, schedule events for other users and create pop-up to-do’s and reminders.
• Slip rules allow you to create a new slip when saving the current slip. For example, if certain activities always have an expense associated, the slip rule will automatically create the related expense slip.
• Delete multiple slips at once.
• Time to pay report calculates the average number of days your clients take to pay invoices.
• Force users out of program for Exclusive Mode functions.
• Restrict slip entry outside of a designated date range.
• Assign multiple prices to expenses.
• Show time in decimal or hours:minutes format.
• Duplex printing option.
• Relative date option in Custom Fields. This saves you time when running electronic bills. You no longer have to enter starting and ending dates manually, but instead just use a relative date formula such as first day of the previous month through last day of the previous month.
• Attach files to bills including TWAIN scan from new slip attachment option.
• Print private slip notes on pre-bill worksheets.

NEW FEATURES in TIMESLIPS 2012
• Customize merge templates for letters to clients.
• Put multiple clients on bill hold.
• To be purged flag allows you to keep "closed" files in the database until ready to be purged.
• Lock out users from database during critical functions, with notification.
• Convert text in description.
• Use up to 6 spelling dictionaries at once.
• Character and word count on slip description.
• Set default payment type.
• Print Timeslips Today dashboard.
• Export past bills to RTF format for editing.
• Date option for replacement slips for better control of items to be summarized.
• New options for storing PDF copy of bills including client folders.
• Email bills without printing first.
• Reduce size of PDFs with exclude embedded fonts option.
• Save time setting up electronic (audit house) billing with import / export client references.
• Access client files from within Timeslips.
• Install add-ons more easily with Help > Purchase Add-On.
NEW FEATURES in TIMESLIPS 2011

- Compatible with Windows 7.
- Workstation level feature control. Improve performance by disabling unused features at the workstation level.
- Improved bill processing lets you approve bills more quickly.
- Nickname 2 increased from 15 to 30 character limit.
- Option to prevent Nickname 2 duplicates.
- Custom name for emailed bills and statements.
- Improved client-level slip entry restriction.
- Integrated credit card payment processing.
- Expanded custom fields allows up to 90 custom fields for Clients, Timekeepers and Activities.
- Improved reporting allows more detailed payment allocation information on bills.
- User-defined invoice listing.
- More control over subtotals and grand totals in user-defined reports.
- Enhanced chart and graph options.

NEW FEATURES in TIMESLIPS 2010

- Client Default Rates Report helps to ensure Clients and Timekeepers are set up properly.
- Clients Not Billed Report. Shows clients that were not billed during previous billing cycles.
- Print to Excel as Displayed.
- Improved Slip Notes. Review and search slip notes from the slip list and include slip notes on user-defined reports.
- Purge Feature improved. You can now select which closed clients you want to remove.
- More fields available for Customizable Section on Bills
- History Bill for the Court improved to include all totals for fees and expenses are now included, and a Timekeeper Summary table can be included on the report.
- Data Entry Navigation Options now let you use the Enter key to move through fields (like the Tab key).
- Rate Analysis Report now allows up to two additional levels of rates breakdown.
- New Custom Field Types and Customization Options. Custom field types now include money, percent, hours, and number values and formatting options for more effective reporting.
- Preview Bills and Reports without saving to Report List.
- Customize E-mail Templates
- Purge Specific Information
- Comma and Dollar Signs on Reports
NEW FEATURES in TIMESLIPS 2009

- Timekeeper WIP/Billed/Paid Report
- Calculated Fields on Reports
- Inactive References
- Automatic Conflict Check
- HTML Help

NEW FEATURES in TIMESLIPS 2008

- Support for Windows Vista
- Billing Assistant now has an easy-to-use list format with a side panel display giving one-click access to all previous Billing Assistant functions plus bill stage functions (proof, clear, approve).
- More filtering options. For example, set up Timeslips to bill clients every 30 days, when clients hit a billing limit, or many other billing scenarios.
- One-click access to Bills and Pre-Bill Worksheets.
- Enhanced user-defined reporting includes A/R.
- Print Timekeeper collections reports that show data for all clients a Timekeeper has worked on during the year, whether the clients are currently open, inactive or closed in Timeslips.
- Print bills showing total hours as either a decimal or a clock format.
- Generate envelopes and labels right along with bills.
- Enhanced on-screen bill editing. You can now remove entire bills or individual slips from printing while previewing them.

NEW FEATURES in TIMESLIPS 2007

- Bill Layout Cover Page
- Improved QuickBooks Link Upgrade
- Create Slips by Email
- Scheduled Backup
- Slip Approval – gives a reviewer control over when slips of designated timekeepers are ready to bill
- Improved Navigator Redesign (Classic Navigator still available)
- Improved Enhanced Spell Check with Grammar Check
- Improved Timeslips Today

NEW FEATURES in TIMESLIPS 2006

- Reprint bills filters: Paid in Full, Unpaid, Partially Paid
- Drill down on reports
• Send reports to Excel
• Improvements to Data Verification
• TAL Pro for QuickBooks included
• All electronic billing formats included for a single price -- $649.95, $49.95 if you have already purchased an e-billing add-on.
• Email bills enhancements, including cc: to other email addresses
• Name-Specific Alerts
• Support for Pre-Printed Bill Forms

NEW FEATURES in TIMESLIPS 2005

• Microsoft Outlook Integration
• Time Sheet Entry without Creating a Template
• Interactive bill preview (drilldown).
• Missing Time Report
• Batch processing of all bills, with different bill layout templates.
• Bill Layout options formerly under the Format tab of Client Information consolidated in the revamped Bill Designer which includes interactive bill preview. Client Information Format tab is now called the Layout tab.
• Back-dated Accounts Receivable Reports.
• Post payments by invoice number.
• Automatic Workstation Update when Service Release Installed

NEW FEATURES in VERSION 12 (Timeslips 2004)

• Email bills.
• TAL Pro for Peachtree ($149 add-on)
• These add-ons that cost extra in previous versions are now included: Split Billing, Fee Allocation, Legal Dictionary
• "My Lists." Show only the clients or other names that you work with.
• Multiple timers can run at once.
• The return of TSTimer, a separate program for time and expense entry only.
• MSDE option discontinued.

NEW FEATURES in VERSION 11

• Time sheet slip entry interface.
• Timeslips Today. Your favorite Timeslips views and reports in a single display.
• Alerts. Pop-up messages to alert you when certain conditions such as over-budget clients arise.
• Print bills to PDF file, batch or separate file for each bill.

NEW FEATURES in VERSION 10.5

• Easier navigation: Improved Menus. Fewer scroll bars.
• Expanded audit reporting: User Assistant (shows what a user has entered/changed in the system). Firm Assistant: Firm-wide totals for all clients showing WIP and AR broken down by fees, costs, interests, with drill-down.
• Split billing: Divide a bill among several clients. (This is an add-on for the Standard edition and included in the Enterprise edition.)
• 20 rates in a rate table in Standard and Enterprise editions.
• TAL (Timeslips Accounting Link) is expanded with TAL Pro for QuickBooks offering bi-directional integration with QuickBooks. TALPro transfers receivables from Timeslips to QuickBooks and sends QuickBooks payables to Timeslips as expense slips.
• Must close Tasks, Expenses before deleting.

NEW FEATURES in VERSION 10

With the release of version 10.1 product versions were changed from Levels 1-3 to Express, Standard and Enterprise.

Basic (Timeslips Express) features added since Version 9.1:

• Spell-Checking (prior to version 10 this was a level 2 item)
• Unlimited clients, tasks (activities) and timekeepers (in version 9.x clients limit is 15000, tasks are unlimited, expenses limit is 250 and timekeeper limit is 100)

Note: In the Express version, Custom Fields consist of six pre-set fields.

Standard (Timeslips Standard) features added since Version 9.1:

• Progress Billing
• Interim Billing
• Categories on activities
• Export bills to RTF
• Update rates wizard
Enterprise (formerly Level 3) features added since Version 9.1:

- Audit Trails
- Discounts on early payments
- Track WIP in GL
- Send Payments to different bank accounts
- Transfer funds between projects
- Bank deposit slips
- Client/Server architecture for MSSQL server (Enterprise only)

**NEW FEATURES in VERSION 9.1**

*This free upgrade is a must for firms who purchased Version 9.*

Enhanced diagnostic and repair tools, technical corrections and user interface improvements including:

- Change order of Task and Client fields on slips.
- Change Classification tool to move a group of clients, tasks, expenses or timekeepers from open to closed, open to inactive, etc.
- Stations that only run an API-based application do not require separate license – In Timeslips v9, every computer that accessed the Timeslips database required a station license. Many users had computers that ran an API-based application, but not Timeslips. These non-Timeslips stations now work without an additionally purchased license.

**NEW FEATURES in VERSION 9**

Version 9 comes in 3 levels.

*Base Features (Level 1) added since Version 8:*

- Invoice tracking
- Balances tracked by fees, costs and interest
- Reverse Payment (returned check) and Write Off (bad debt) transactions
- Append slips to existing archive file
- Permanent slip numbers (no renumbering after purge)
- Multiple timers allowed for a single timekeeper
- "Unlimited" open and closed slips (do not exceed 300,000 slips)
- Unlimited References
- Unlimited Transactions (was 512 per client)
- Default reference and required reference options
• Multiple global reference lists
• Longer descriptions for references
• Unlimited monthly history periods
• Client information templates
• Minimum hours flat fee
• Data-entry templates for nicknames to enforce specific structure on the names. For instance, if you always enter nickname 2 as 3 digits, dash, 4 digits, you can enforce this entry convention. Users, Activities and References also support data entry templates.
• Reprint a bill to display
• Expanded field sizes
  - Nickname 1 now 30 characters (was 15)
  - Full name and address lines now 60 characters (was 35)
  - Client notes now 30,000 characters (was 2,000)
• Up to 30 custom fields
• Up to 1,000 list items within custom fields
• Up to 1,000 abbreviations, plus 1,000 personal abbreviations
• Unlimited rate overrides

New User Level 2 features (those not available in Level 1)\textsuperscript{1}:

• Spell Checking
• Extra field on a slip (Custom field on a slip)
• All billing arrangements (level 1 hides industry specific ones like Percent Complete and Contingency)
• \textbf{User (Timekeeper) History}
• Overhead cost of users
• Basic Budgeting
• \textbf{User Summary Table on bills}
• Make Overhead Clients
• Deadbeat client warning on slip entry
• Practice Management Reporting (adds many reports):
  • Statements show a history of recent invoices and payments along with a running balance that you can send to a client.
  • Overhead Cost report compares employees' hourly value against billings.
  • Flat Fee Performance report shows profit or loss when using flat fees.
  • Payment Performance report helps determine how payments are apportioned to each timekeeper.
  • Payments are assigned to timekeepers according to their associated billings across various periods.
  • Tax Collection Summary report provides an analysis of how much was billed and paid for each tax rate.

\textsuperscript{1}Upgraders retain all features of their current Timeslips version, plus these. Level 1 is a scaled down version of the program with features similar to Timeslips 8.
• Aged work-in-progress reports show status of each client's unbilled charges.
• Productivity Analysis report shows a table of hours, fees and costs comparing billable and unbillable amounts by week, month, quarter or year.
• Profitability Analysis report compares the pre-bill time charge amounts to the amount actually billed by week, month, quarter or year.
• Budget reports compare the actual hours, fees and costs to the budgets on each client.
• Charges On Hold report shows the total of time and expense charges on hold from the next bill.
• TAL (Timeslips Accounting Link) included for new users.

New User Timeslips 9 Level 3 features (those not available in Level 1 or Level 2):
• 20 rates in a rate table
• multiple client funds accounts
• Custom fields on users/activities = 30
• conflict and text search
• Legal Spell Dictionary
• **Extended budgeting**
  With Level 3, you can generate budgets on groups of employees and projects.
• Fee Allocation/Collection Reports
  Four Fee Allocation reports are essential for law firms to analyze how much originating and responsible attorneys and other employees receive from each payment, in detail and monthly (periodic) formats.
• Timeslips Accounting Link (TAL) when upgrading, even if you did not have it previously. (TAL is always included for new users).  TAL allows you to track receivables by invoice, allocate payments automatically to fees, costs and interest in the order desired, post payments by invoice, produce additional reports including income reporting by timekeeper, originating or billing attorney, produce a general ledger transfer register and electronically link to popular accounting software.

Add-On
• Bill auditing (electronic billing) $599.95 per format

**NEW FEATURES in VERSION 8**

Upgraders will notice these new features in Timeslips Deluxe Version 8:

• Full text search
• Billable and unbillable time on the same slip
• Apply adjustments to activities and expenses
• Apply adjustments to specific slips
• Apply markups and markdowns to specific slips
• Revision stage
• Underline, bold and italics in descriptions
• Show interest, balances and other data values in bill messages
• Purge function centralized
• Less restrictions over network
• Tabbed views / right-mouse menus
• Print from display screen.

NEW FEATURES in VERSION 7

TSTimer
• Slip defaults
• Custom tab order
• Bookmarks
• List view and printing slips from list view
• Client info on new clients

TSReport
• Hide/Show inactive clients
• Transaction report by date
• Report wizard
• Expanded activity information
• Relative date fields in selections
• User summary on pre-bill
• User summary ordering
• More script commands
• New fields in client history: actual fees and actual cost (actual billed value of slips)
• History included in bill layout
• Total only option on consolidated bills
• Funds report showing running balance
• Pop up calendar for date fields
• Abbreviation expanded from 5 to 8 characters
• Personal abbreviations
• Prompt in abbreviations
• Custom labels for phone number fields

NEW FEATURES in VERSION 6

• The Billing Assistant
• Control over nickname 2
• Reprint bills
• Proof stage
• More billing arrangements: rate rules, replenish client funds, contingent fee, percent complete
- Customizable sections on bill
- Customizable matter summary on consolidated bills
- Enhanced bill layout
- More bill format options at the client level: subtotal add to flat fee slips, new tax style, single total for time and expense sections.
- Scripting
- Customizable navigator
- Billed slip value on slips
- "Unlimited" slip capacity with close slips feature (please do not exceed 300,000 slips)
- New reports: periodic totals, overhead cost, improved user-defined slip report, multiple budgeting, change fonts on reports
- Date type custom client field
- Address book
- Four phone numbers per client
- Increased transactions capacity (from 128 to 512)
- MiniView in TSTimer
- TS Import greatly improved
- DOS Timer

TAL

- AP Link for some accounting packages
- Apply payments to multiple invoices
- Payment performance report
- Aged invoice report